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Writer’s Café is a software toolkit for creative writers of all kinds. It helps you 
record and organize your thoughts, with a variety of features including 
Notebook, Journal, Scrapbook, Pinboard, and most importantly, StoryLines, a 
sophisticated story structuring tool. 

Writer’s Café is a little different from other fiction writing software packages 
you may have tried. This is because I’ve tried them too and found they didn’t 
help with the specific writing problems that I was trying to solve in my work: and 
many of our customers have reported the same experience with other tools. 

Successful writing comes when you get into a particular state of mind. It’s 
like shifting into a different gear. Ideas for stories aren’t so very hard to come 
by but transforming them into a successful, well-written narrative is another 
matter entirely. Writer’s Café is designed to be a nurturing environment that lets 
your mind explore all the possibilities. It won’t tell you what to do. It won’t churn 
out pre-drawn plot schedules for you to follow, or hinder you by demanding 
answers to unanswerable questions. It will let you relax so that you can jump 
into the world of your imagination and play there. 
 
I’ve written a 60-page e-book to support the tools which you can find in the 
Bookshelf section (to read within Writers Café) and in the Home window (as a 
PDF file, to read or print out using Adobe Acrobat Reader or equivalent 
program). Fiction: The Facts is a distillation of 20 years of writing experience 
and should help you form a good understanding of the art and craft of story. 
Plus, my Writing Recipes are additional packets of writing advice that can be 
shown as tips when you start Writer’s Café, and browsed at other times. 
Further inspiration is available from our collection of writer’s quotations 
(‘Cookies’), and the Technical Tips help you make the most of the software. 
 
This Getting Started guide is intended to give you a bird’s-eye view of Writer’s 
Café so you know what to expect and where to find it. First we’ll look at the 
Writer’s Café Home window and how to get online help. We’ll briefly cover a 
variety of tools such as the Scrapbook and Journal, before discussing the story 
structuring tool StoryLines in a little more depth. Finally, there’s a table of 
keyboard shortcuts that you may find useful to keep by your computer. 
 

What is
Writer’s Café?

Accompanying 
material

About this guide
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Using Writer’s Café 
 

The Home window is the 
first thing you see when 
running Writer’s Café. It 
contains the Organizer on 
the left where you can 
access recently-viewed files 
quickly, explore the contents 
of your hard drive, and 
organize ‘workspaces’ (files 
to load when Writer’s Café 
starts). 

The Desktop on the 
right contains icons for a 

variety of Writer’s Café tools and documents, including our writing guide 
Fiction: The Facts, StoryLines, and more. Double-click an icon to launch a tool, 
or hover over the icon to see a description. The tools displayed here are also 
available from the Tools menu, and on Windows you can access them by right-
clicking on the Writer’s Café tray icon and selecting from the Tools menu. The 
Desktop also contains links to some external tools, and you can add your own 
as well as customise the way the desktop looks. Some of the Writer’s Café 
features will display on the desktop – these include the Notebook, Journal,
Cookies, and Name Generator. Click on the desktop background to hide the 
tool when you’ve finished with it, or click to the right of the tool. Others, such 
as the Scrapbook, will replace the Home window while you’re using them, and 
you can get back by clicking on the toolback. 

If you click on the button you’ll see a handy menu of 
documents, tools and commands as an alternative to using the 
icons. From this menu, you can also create text and picture notes 
that will show permanently on the Desktop until you choose to 
delete them. You can even create a slideshow note that displays the contents 
of a folder – you can create a set of pictures to inspire you, and show a new 
one every few minutes. 

Remember that you can always get back to the Home window by pressing 
on the toolbar, or using the Tools | Home menu command, or by typing 

Ctrl+1 or Shift+Ctrl+Home.
At the bottom of the Writer’s Café window, there’s a status bar which 

displays the timer display, useful for timed writing. The status bar also displays 
brief help when you’re hovering over toolbar buttons and menu items. 

There are several ways to get further help. Click on (or Help | Describe 
Window, or in a dialog box caption) and then on a window to show a short 
description of the window, sometimes with a link to more detailed online help. 
You can press the F1 function key to see the same information for the window 
or control under the mouse. You can show the online help contents with Help | 
Contents, or you can browse the online help and other Writer’s Café 
documents from the Bookshelf tool. Most dialog boxes also have a Help 
button that shows detailed information about the dialog. 

The
Home Window
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Write a little every day if you 
can! If you have been trying to 
write, but aren’t sure what 
direction to take just yet, the 
Writer’s Café Notebook is the 
place to explore those first 
thoughts. We’ve designed it as 
a friendly, simple, non-
distracting space. If you find 
yourself on a word roll (and we 
hope you do), the page will 
scroll down as you write. The 
notebook automatically saves 
your pages and you don’t have 
to give it a filename unless you want to use several notebooks, for example for 
different projects, subjects or stories. Access the notebook by double-clicking 
on the Notebook icon, or choosing the Tools | Notebook menu command, or 
typing Ctrl+5.

For many writers, keeping a record of their life and thoughts is a fundamental 
part of their method. It’s certainly a great habit to get into and the Writer’s Café 
Journal is always there to get you writing every day. You can paste in a writing 
prompt if you are stuck for a subject (see below), but it’s your decision. 
Remember, you don’t have to write something brilliant every time. Just writing 
is enough. Access the journal by double-clicking on the Journal icon, or 
choosing the Tools | Journal menu command, or typing Ctrl+4.

If you are stuck for something to write, try pasting one of our writing prompts 
into the notebook or journal and take it from there. To show the writing prompt 
dialog, use the Help | Writing Prompt menu item, or type Ctrl+Alt+J, or click 
the button on the toolbar. There are several kinds of prompts ranging from a 
simple topic to write about, to a story consisting of characters, a location, a 
goal, and an obstacle. Writer’s Café generates a suggestion for each of these 
elements and then lets you loose 
on it. 

If you are really stuck, try 
setting the timer for only ten 
minutes. You may find it easier to 
focus if you only have to write for a 
few minutes than if you have an 
unspecified amount of time. It is 
also ideal for when the rest of your 
life is pressing in on you and you 
are trying to make time for your writing. Using the timer, half an hour a day can 
easily be marked out as your special writing time – and become part of your 
daily routine. You’ll be surprised how your material mounts up and you’ll feel 
you are really achieving something. 

To use the timer for other purposes, click on the digital clock face on the 
bottom right of the Writer’s Café window, or use the View | Timer menu 
command. 
 

Writing Prompts,
for instant
inspiration

The Journal

The Notebook



GETTING STARTED WITH WRITER’S CAFÉ 4

The Scrapbook is a multifunctional 
space designed to help you explore 
and research your creative projects. 
It organizes all those bits and pieces 
that stir your imagination and you 
need to keep handy.  

Double-click on the Scrapbook 
icon, or choose the Tools | 
Scrapbook menu command, or 
type Ctrl+3. You can browse the 
structure of your scrapbook on the 
scrapbook index on the left, and view the scraps themselves on the right. 

To create a new scrapbook (collection of scraps), click on the toolbar 
button (or Ctrl+N, or File | New Project) and choose a name and filename. 
Now you can create scraps and folders using the toolbar button. Save the 
scrapbook with (or Ctrl+S, or File | Save) and open an existing one with 

(or Ctrl+O, or File | Open). 
These are the types of scrap you can create:  

Text Scrap: Just type! This is the place for recording those back-of-the-
envelope, inspirational moments. You can apply styles to your text with the 
formatting toolbar or commands on the Format menu, and you can insert 
pictures via Format | Insert Picture or by pasting from the clipboard. 
Image Scrap: You find a great picture in a magazine that says something 
about your story or a photograph of someone who looks just like your heroine. 
This is the spot for keeping them. 
Web Link Scrap: Store your web addresses in scraps of this type. Either type 
or paste an address, or (on Windows), surf in Writer’s Café’s Web tool and 
when you find a site that interests you and you want to bookmark, click on to 
store the address as a web link scrap. Then when you look at the scrap again, 
the web site will appear inside the scrap. 
Folder Scrap: you can use this to make hierarchies in your scrapbook. 
Shortcut Scrap: store references to documents or programs on your 
computer. Drag a file from Windows Explorer or browse for a file, then click on 
Launch to edit the document or run the program. 
Collage Scrap: This is a flexible brainstorming 
tool to encourage blue-sky thinking and 
constructive daydreaming. There is a stage in 
creating a story when you have collected a heap 
of ideas which appeal to you but which you can’t 
get into any coherent order. The collage tool 
allows you to lay down ideas in an unstructured 
but graphical form so you can see exactly what 
you’ve got. You can put text in shapes, and add 
images. Everything can be moved about at will, and you can add links with 
arrows between items if you like. You can change all the colours. All in all, it’s a 
fun place to explore your ideas. 

The Scrapbook
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This is a collection of my favourite quotations about writing, randomly 
presented for your sustenance and amusement! To see a new cookie, press 
the spacebar. 

The Writer’s Café manuals, the Fiction: The 
Facts book and more are all  available from 
within Writer’s Café without using an external 
help viewer. Click on or Help | Contents 
and select a book to view. You can browse 
through the topics using the Contents tab on 
the left, or you can use the Index or Search 
tabs to find the topic you’re looking for. To 
expand the topic to take up the whole window 
for easier reading, click on the button, and 
then on the button to restore it to the 
original size. You can click on to detach the Bookshelf from the main window, 
and closes the Bookshelf. 
Fiction: The Facts is also available as a PDF file for viewing or printing; you can access it from a Desktop 
icon. 

 
Sometimes you’ll find you want to 
quickly jot down short notes without 
having to worry about where they 
should go. This is where the 
Pinboard comes in. When Writer’s 
Café first runs, it creates a default 
pinboard called Pinboard.wcp, and 
you can start adding text and image 
notes, edit them, drag them around, 
and change their size, formatting 
and colours. Think of the Pinboard 
as a virtual ‘fridge’ where you can 

stick your random ideas and pictures that appeal to you. Or you can create a 
new Pinboard file with File | New Project, for a specific writing project. To 
access the Pinboard, use the Tools | Pinboard menu command, or double-
click on the Pinboard icon on the Desktop, or type Ctrl+6.

The Names tool provides a fun and quick 
way to generate candidate names for your 
characters. You can generate male and 
female names, either forenames or 
surnames or both, and store possible 
names for future reference. You can also 
browse the name lists directly. You’ll never 
need to look through a telephone directory 
for inspiration again! To access this tool, 
double-click on the Names icon on the 
Desktop. 

Cookies

The Bookshelf

The Pinboard

Names
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Using StoryLines 
 
StoryLines is all about helping you 
to develop and transform your 
ideas into a detailed blueprint that 
you can use to write a script or a 
novel. 

Writers have always used 
scraps of paper, blank index cards 
or postcards to record separate 
incidents in their stories and then 

sort them into the best possible order and identify the gaps in the story. 
StoryLines takes this concept to the next level, allowing you to write and record 
and organize your virtual cards really quickly.  

Keeping track of a plot, making sure it has a unity and a proper structure is 
no easy feat – and these days, most stories have more than one plotline. 
StoryLines allows you to plan each plot on a separate line and arrange the 
events you have recorded on the cards to create the best effect. If you have the 
idea that you want your love story to be resolved before the espionage plot 
plays itself out, StoryLines makes it easy to see if that works, and to try out all 
the alternatives without loads of rewriting. 

To access StoryLines, double-click on the StoryLines desktop icon, or 
select the Tools | StoryLines menu command, or type Ctrl+2.

Click on (or File | New Project or Ctrl+N)
to start creating a new project. StoryLines 
asks you to give a name for your project, and 
to name up to three storylines. You only need 
to name one storyline, and the name can be 
quite arbitrary, so don’t worry if you haven’t 
got all the details straight in your mind. You 
can easily add or delete storylines at any 
time. 
 
StoryLines is divided into three main areas. 

The project outline is on the left, where 
you can see a bird’s-eye view of your story. 
Click on an item to start editing that card; drag 
cards to change their ordering and right-click to 
show a menu of further commands. The outline 
window also contains the StoryLines toolbar 
along the top, supplementing the main Writer’s 
Café toolbar with StoryLines-specific 
commands. Alongside the project outline tab 
there are tabs for further tools, for adding project notes and recording story, 
character and location details. 
 

Creating a 
StoryLines 

project

The main 
elements of 

StoryLines
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The card editor area is on the right, and 
contains a number of tabs for entering a 
card’s summary, content, and other details. 
You can also record project notes and view 
reports. This picture shows the content editor, 
with paragraphs formatted using the standard 
StoryLines screenplay styles. This is where 
you type the actual story, and StoryLines will 
stitch the content for all the cards into a linear 
report. 

The storyline window is at the bottom of the window, and it’s where you 
arrange your cards, dragging them to new positions and scrolling to see more 
cards. If you wish, you can use the command to wrap the cards at the right-
hand edge so you only ever have to scroll up or down. 
 

Note that tabs can often be split to allow you to see several windows at 
once. Just drag the tab to the top, right, bottom or left section of that tab’s 
window to split it, or drag the tab to a different row of tabs. 
 
To add a new card, click on (or type Shift+Ctrl+C, or StoryLines | New 
Card). You can now start typing text into the Summary tab of the card editor, 
and create further cards, dragging them to the appropriate storyline. To keep 
creating cards on a specific storyline, select the storyline by clicking on its label 
on the left of the window. 

You’ll see the cards being added to the outline, and you can click on an 
item in the outline to go to that card quickly. Click on the Reports tab to see a 
linear version of your project, updated as you work: we’ll look at that in more 
detail shortly.  

You can switch the Master Storyline view on using StoryLines | View | 
Master Storyline, so you can see the overall shape of your story. 

 
You use the Summary, Content, Annotations and Properties tabs to enter 
details for each card.  

The Summary tab records facts about the scene or incident you are 
dealing with at this point in the story. The summary text is used to identify the 
card in the project outline. This tab allows allow you to specify time and location 
details, mainly of use when writing screenplays. 

The Content tab can have as much detail as you want – perhaps the entire 
scene. The editor allows application of named styles or ad-hoc formatting such 

Creating cards

Editing cards
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as centering and font changes, so you can control your story appearance as 
desired. If you’re a screenwriter, there’s extra help and some automated 
application of styles for cues, dialogue, transitions and more. 

The Annotations tab lets you write notes about the scene or incident, and 
the card will show a yellow corner if there are any annotations. You can have 
as many separate annotations as you wish per card, and you can add both 
formatted text and images. 

The Properties tab contains further windows for ‘tagging’ cards (putting 
them in user-defined categories), linking the card to other cards or sheets, and 
showing statistics – word and page count – for the card and project. 
 
Left-click on a card to edit it (on the Mac, just click), and right-click on a card to 
popup a context menu with commands that apply to this card (on the Mac, use 
control-click). 

Cards can be dragged individually using the left mouse button, or you can 
select several cards and drag them all. You can select cards by left clicking on 
the each card’s coloured bar with control held down (hold down shift on Mac) or 
by dragging a selection box around a group of cards, or by choosing Select All 
on the context menu (also by Ctrl+A). You can deselect cards using the 
context menu, or by clicking anywhere on the window background. 

Undo and Redo can be applied to most commands. This can be 
handy when you've dragged a card somewhere you didn't want to, for example, 
and want to quickly revert to the previous position. 

A card can have the navigation focus as well as be selected. There is only 
ever one card with the focus, and it is highlighted by a flashing colour bar. 
When you create a new card with Shift+Ctrl+C or the StoryLines | New Card 
command, it is created after the focus card in an available column or in a newly 
created column. 

You can navigate around the storyline window with the keyboard arrow 
keys, using Alt+Left, Alt+Right, Alt+Up, and Alt+Down. The current focus will 
be set to the first card in the specified direction. Alt+Home and Alt+End will 
take you to the start and the end of the storyline window respectively. 

You can insert a column in front of the focused card with Alt+Insert, and 
delete selected cards or the focused card using Alt+Delete.

Columns can have labels: left-click on a column number to edit a label, and 
press Return to finish editing the label. 

You can Copy , Cut and Paste cards, so long as the storyline 
window is focused and not a text field. Click on the storyline window 
background to ensure that the keyboard focus is on the window. 
 
If you wish, you can organize your project into 
multiple levels. For example, a large novel 
might be structured as Parts, Chapters and 
Scenes. The Scene level is where the actual 
story is written and the other levels are there 
to help you organize and navigate the story. 
When creating a new project or sheet, you 

More on editing

Adding 
structure
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can choose the structure, either by selecting an existing ‘standard’ structure 
definition, or by editing the levels yourself. You can decide on how levels will be 
labelled and numbered. The structure will be shown in the outline and you can 
add cards to any of the levels. You always edit an entire level at a time, even if 
it straddles multiple sections at higher levels. For example, when editing the 
Scene level, you will see all the scenes in the story, with thick vertical bars to 
show the Chapter boundaries. Note that this is optional – you can work with 
one level only if you wish, and you can also change the structure at a later date 
from Sheet Properties (press on the StoryLines toolbar). 
 
You can associate your name with the 
project (to be in included in reports) and 
record other details of your story in the 
Story tab. The Characters and 
Locations tabs let you maintain profiles of 
the people and places in your story, and 
again these details can be included in 
your reports. You can find these tabs next 
to the Outline tab. 

You can see how your story is coming 
along by clicking on the Report tab. Here, 
StoryLines combines the cards in your 
story to produce a linear version. In the 
drop-down list, you can select a template 
suited to your story, for example Novel or 
Screenplay. Then scroll through the report 
or click on a card in the outline or storyline 
window to scroll to particular scenes. You 
can also choose the scope of the report – 
Current Level, Current Sheet, or Whole 
Project. 

You can preview the current report 
before printing it by clicking on  , and 
print it by clicking on . You can also 
export the report to a number of formats, 
invoking the export wizard (right) with 
Ctrl+E or File | Export. If you choose the 
OpenDocument format, you can export to 
OpenOffice.org Writer and Microsoft Word 
(using OpenOffice or an add-in), 
preserving formatting styles. You can also 
export to (and from) screenwriting 
software such as Final Draft. 

Editing story 
information

Viewing, 
printing and 

exporting 
reports
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The level of detail shown in a 
report can be changed  in the 
Report Template Dialog (right), 
accessed via the StoryLines 
Preferences, or on the Report 
tab. You can create your own 
report templates to show exactly 
the content you wish. For 
example, you could choose to 
only show content and not card 
summaries, or you could opt to 
show the storyline name in the 
card headings. You can also edit specific paragraph formatting styles to 
change the appearance of report text and give yourself access to more named 
styles when editing content. 

There are two established schools of thought about starting a project. On the 
one hand there is the school of meticulous planning that considers it a sin to 
start chapter one or scene one until everything is worked out down to the last 
plot twist. The other school tells you to plunge right in and just do it, trusting to 
instinct and inspiration. The first method means you are well prepared, but can 
trap you by giving you too rigid a blueprint for your story. On the other hand, 
the second method means you can find yourself lost in a fictional desert without 
a map or a clue. 

Storylines can help you to avoid the pitfalls of both systems and lets you 
harvest their respective strengths. When you are planning your intricate plot 
and you feel you have to write a particular scene out in full, you can switch to 
the content section of a card, and go with the flow. If, on the other hand, you 
are exploring the substance of your story by writing actual scenes and 
suddenly the best ending ever occurs to you, it’s easy to play with the cards 
and get on top of the structural demands of your story. Whichever way you like 
to play it, StoryLines is there to help you. 

This brief guide can only scratch the surface of Writer’s Café, but we hope it 
has given you sufficient information for you to get stuck in and explore the 
tools, samples and online help. If in doubt, remember the button, the F1 key, 
and the Help button on each dialog box. You might like to use the Check for 
Updates command on the View menu occasionally, to check for free 
upgrades. 

StoryLines 
suits your 

style

Where next?

Customising 
your report 
templates
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These are the shortcuts you can use to accelerate your use of Writer’s Café. 
Note that some shortcuts are dependent on context: that is, which window has 
the focus. For example, if you are typing text into a card, Undo and Redo affect 
the text field, while if the storyline window has the focus, Undo and Redo apply 
to edits such as card creation, deletion and moving. 
 

Ctrl + A Selects all text in an edit control. 
Ctrl + B In a styled text control, emboldens the selection or starts formatting in bold. 
Ctrl + C Copies the selected text or image to the clipboard. 
Ctrl + E Exports the current file, if supported by the active tool. 
Ctrl + F Shows the Find dialog. 
Ctrl + G Regenerates the current StoryLines report. 
Ctrl + H Shows the online help. 
Ctrl + I In a styled text control, italicises the selection or starts formatting in italics. 
Ctrl + K Shows the StoryLines Pockets window. 
Ctrl + L Shows the StoryLines Sheet Properties window. 
Ctrl + M On Windows and Linux, shows the backup manager window. On Mac, 

minimizes the active window. 
Ctrl + N Creates a new project. 
Ctrl + O Opens a project. 
Ctrl + P Shows the print dialog for printing the current document. 
Ctrl + Q On Mac, quites Writer’s Café. 
Ctrl + R Shows the Find and Replace window for searching through the current 

document and replacing text. 
Ctrl + S Saves the active project and all its contents. 
Ctrl + T Shows the Settings dialog.   
Ctrl + U In a styled text control, underlines the selection or starts underlining. 
Ctrl + V Pastes text or an image from the clipboard to the text control or image scrap. 
Ctrl + W Closes the current window, which may close Writer’s Café. 
Ctrl + X If a text control is selected, copies the selected text to the clipboard and deletes 

the text. 
Ctrl + Y Redoes the previously undone edit. 
Ctrl + Z Undoes the previous edit. 
Ctrl + Tab (Win) 
Ctrl + / (Linux) 
Alt + Tab (Mac) 

Shows a menu for navigating quickly to a window. 

Ctrl + Backspace Goes back a page in the embedded web browser. 
Ctrl + Page Up Goes to the previous journal entry or notebook page. 
Ctrl + Page Down Goes to the next journal entry or notebook page. 
Ctrl + 1 Shows the Home window. Alternative: Shift + Ctrl + Home.
Ctrl + 2 Accesses StoryLines. 
Ctrl + 3 Accesses the Scrapbook. 
Ctrl + 4 Accesses the Journal. 
Ctrl + 5 Accesses the Notebook. 
Ctrl + 6 Accesses the Pinboard. 
Ctrl + 7 Accesses the Web tool (Windows only). 
Alt + Enter Shows the properties dialog for the current project or scrap. 
Alt + Del Deletes the focused card. 
Alt + Insert Inserts a column at the current pointer position. 
Alt + F4 On Windows and Linux, quits Writer’s Café. 
Alt + Up Goes to the previous scrap. 

Keyboard 
Shortcuts
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Alt + Down Goes to the next scrap. 
Ctrl + Alt + 1 Decreases the overall text size in a text editor. 
Ctrl + Alt + 2 Increases the overall text size in a text editor. 
Ctrl + Alt + A If the Content pane is active, prompts for an annotation and links it from an icon 

(and selected text if any). 
Ctrl + Alt + B Shows a report for the current StoryLines project in your web browser. 
Ctrl + Alt + C Creates a collage scrap. 
Ctrl + Alt + D Exports an OpenDocument report from StoryLines. 
Ctrl + Alt + E Shows or hides the StoryLines card editor and report windows. 
Ctrl + Alt + F Creates a folder scrap. 
Ctrl + Alt + G Shows the global search dialog. 
Ctrl + Alt + H Goes to today’s journal entry. 
Ctrl + Alt + I Creates an image scrap. 
Ctrl + Alt + J Shows the Writing Prompt dialog. 
Ctrl + Alt + L Shows or hides the StoryLines label window. 
Ctrl + Alt + M Shows or hides the StoryLines master storyline. 
Ctrl + Alt + N Shows or hides the StoryLines navigator window. 
Ctrl + Alt + O Shows or hides the StoryLines outline window. 
Ctrl + Alt + P Prints the active item only. 
Ctrl + Alt + S Creates a shortcut scrap. 
Ctrl + Alt + T Creates a text scrap. 
Ctrl + Alt + U Creates a web link scrap. 
Ctrl + Alt + V If there is image data on the clipboard, it will be pasted into a new image scrap. 

If there is a web address on the clipboard, a new web link scrap will be created. 
If there are multiple lines of text on the clipboard, a new text scrap is created. 

Ctrl + Alt + W Enables or disables StoryLines card wrap mode. 
Ctrl + Alt + X If the Content pane is focused and an annotation link is under the cursor, 

deletes the link and (optionally) the annotation. 
Shift + Ctrl + Home Shows the Home window. Alternative: Ctrl + 1.
Shift + Ctrl + C Creates a new card on the currently selected storyline. Alternative: Alt + N.
Shift + Ctrl + F Shows a font formatting dialog for the active styled text editor. 
Shift + Ctrl + N Creates a new StoryLines sheet. 
Shift + Ctrl + O Imports a file into the current or new project, if supported by the active tool. 
Shift + Ctrl + P Creates a new Pinboard picture note. 
Shift + Ctrl + T Creates a new Pinboard text note. 
Shift + Ctrl + U In the Web tool, prompts for a URL (web address) to open. 
Ctrl + RClick Creates a new StoryLines card. 
F1 Shows help on the control under the mouse pointer. 
F2 Shows the StoryLines card Summary pane. 
F3 Shows the StoryLines card Content pane. 
F4 Shows the StoryLines card Annotations pane. 
F5 Reloads the current browser page. 
F6 Shows the StoryLines Report pane. 
F8 Shows the StoryLines Floating Card Editor. 
F11 Shows the current tool full-screen. Press again to restore the window.  
F12 Shows the Spelling Checker dialog. 


